3. Graph and Fit Data with MS Excel 2007™

3.1 Introduction

The saying "A picture is worth a thousand words" applies equally well to tabulated data. It is considerably easier to glance at a graph to find a pattern than to sort through several pages of numbers and try to estimate the amount of variation. To this end, when we take data, we graph it. If we can find an equation which describes the data well, we can extend our understanding by developing an empirical (found by experiment) mathematical formulation.

We have already seen this during our introductory lab when we were trying to graph some data. We have also learned that graphing data by hand is somewhat long and tedious procedure. At the same time computers can do it in much faster and accurate fashion, like the position vs. time graph, which we have obtained with the help of GLX and the motion sensor. Even in this case not only we need to see the graph but we should also be able to analyze a mathematical function which describes it. Computers can help us with this task as well.

In this lab exercise, you will be given some measured data (with uncertainty) and you must plot it, fit a trendline, calculate an additional set of data, graph that, and fit another trendline.

- **Uncertainty**: How well you trust your numbers. There is a numerical range about your result that denotes the variation due to the precision of the instruments.
- **Accuracy**: How close your number is to the "true" value.
- **Precision**: The size of your uncertainty.

The ideas of accuracy and precision can be described by trying to point out a feature on a map. Accuracy tells how closely you point to that feature. Precision describes what you use to point. If you point with a pin, you are being very precise (regardless of your accuracy). If you point with a two-by-four, you are being very imprecise (regardless of your accuracy). Notice that imprecision (large uncertainty) masks accuracy. If your answer agrees with the expected result because you have large error-bars, then you may or may not be accurate. You need high precision (small error-bars) to determine if you are accurate. You need to be accurate in order to trust any theory which is based on your results.

Table 1 shows some data. The units of the measurements have been made up to reduce the influence of what you may already know. Notice that when measuring, you may be able to judge the result better than the accuracy of the instrument. If this is the case, use your best estimate, but keep an uncertainty as the precision of the instrument and consider it a cautious over-estimate.
<table>
<thead>
<tr>
<th>x (draps)</th>
<th>y (cooms)</th>
<th>y (cooms)</th>
<th>Y (cooms)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>±0.75</td>
<td>±1.0</td>
<td>±1.0</td>
</tr>
<tr>
<td>1.0</td>
<td>6.0</td>
<td>5.5</td>
<td>5.5</td>
</tr>
<tr>
<td>3.0</td>
<td>8.5</td>
<td>7.5</td>
<td>8.75</td>
</tr>
<tr>
<td>4.0</td>
<td>9.0</td>
<td>9.0</td>
<td>9.25</td>
</tr>
<tr>
<td>6.0</td>
<td>11.5</td>
<td>12.0</td>
<td>11.75</td>
</tr>
<tr>
<td>8.0</td>
<td>14.5</td>
<td>13.0</td>
<td>14.25</td>
</tr>
<tr>
<td>11.0</td>
<td>16.75</td>
<td>17.5</td>
<td>16.75</td>
</tr>
<tr>
<td>14.0</td>
<td>23.0</td>
<td>20.0</td>
<td>21.25</td>
</tr>
<tr>
<td>16.0</td>
<td>22.25</td>
<td>24.75</td>
<td>24.5</td>
</tr>
<tr>
<td>19.0</td>
<td>25.5</td>
<td>27.0</td>
<td>29.0</td>
</tr>
<tr>
<td>22.0</td>
<td>32.0</td>
<td>31.75</td>
<td>32.75</td>
</tr>
<tr>
<td>6.0</td>
<td>35.25</td>
<td>35.5</td>
<td>36.75</td>
</tr>
</tbody>
</table>

**Table 1**: Measured Data in Specific Units. The second line is the uncertainty in the measurement.

<table>
<thead>
<tr>
<th>x (draps)</th>
<th>y (cooms)</th>
<th>y (cooms)</th>
<th>y (cooms)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>±0.75</td>
<td>±1.0</td>
<td>±1.0</td>
</tr>
<tr>
<td>3.0</td>
<td>7.75</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8.0</td>
<td>14.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>14.0</td>
<td>20.75</td>
<td>22.5</td>
<td>22.25</td>
</tr>
<tr>
<td>16.0</td>
<td>24.0</td>
<td>25.25</td>
<td></td>
</tr>
<tr>
<td>19.0</td>
<td>28.0</td>
<td>28.0</td>
<td>25.5</td>
</tr>
<tr>
<td>26.0</td>
<td>34.0</td>
<td>33.25</td>
<td></td>
</tr>
</tbody>
</table>

**Table 2**: Additional Measured Data. The values for \( x = 3 \) and 8 were taken for verification. For \( x = 14 \) and 19, the numbers had a surprising variation when compared to the uncertainty. For \( x = 16 \) and 26, the data were a little more spread, but not so much as some others.
Some comment about this data:

- The data for $x$ were decided upon and the instrument was set to give specific $x$ values.
- The experiment was performed by groups of three and each individual made a measurement of $y$.
- Some of the data (as for $x=8$) vary by nearly twice the uncertainty. The true answer is probably close to 14.0 or so. In order to minimize the effect of the inherent uncertainty in any given measurement, you should take multiple readings for every measurement. An average of these measurements will sort out this variation.
- You may find (as for $x=14$) that one measurement is peculiarly different. In this case, you should take additional readings for this measurement. This is an indication that "human error" may have an effect (i.e., that the measurement is awkward to make). If multiple measurements vary by more than twice the instrument precision, then you should increase your uncertainty to account for the difficulty of the measurement. Take an average and let the uncertainty be the maximum of either the instrument precision or the data variation about the average. Some additional measurements have been made and are included in Table 2.

We are now ready to use Excel. But first, some notation:

- There is an index. Most indexed topics are boldfaced.
- We will use square brackets to indicate individual keys or buttons for you to press.

For example, pressing [Enter] on your keyboard is different than typing enter on your keyboard: [e][n][t][e][r]. Further, if we say "type [d][a][v][e]" we mean that you should not press [Enter] afterwards. If we say "type [d][a][v][e][Enter]" or if we say "enter [d][a][v][e]" we mean that you should press [Enter] afterwards.

- When we say "click such-and-such" we mean for you to use the mouse to point to a location on the screen and press the left-most button on the mouse one time. (A single click will usually select something which can then be used.)
- When we say "double-click such-and-such" we mean for you to use the mouse to point to a location on the screen and press the left-most button on the mouse two times in rapid
succession. (A double-click will usually produce an action by the computer beyond simply selection.)

- When we say "right-click such-and-such" we mean for you to use the mouse to point to a location on the screen and press the right-most button on the mouse one time. (A right-click will usually produce an appropriate menu from which you can select an action to be performed.)

3.2 Navigating Excel

1. Log into the computer and open a new document in Excel: Open Excel by using the mouse to click the [Start] button. This will pull up a menu. Click [Programs]. On some computers you will then see [Microsoft Excel] or [Excel] as an option -- click it. On other computers you will need to find [Microsoft Office], click this, and then click [Microsoft Excel] on the new menu that comes up.

   If you are using Vista, click the [Windows Icon] (it looks like a flag) in the bottom left corner. This will pull up a menu. Click [All Programs] and then [Microsoft Office]. This should open up a menu with a list of different Office programs. Click on [Microsoft Office Excel 2007] to open the program.

2. You should get an empty spreadsheet (a white page with grayish horizontal and vertical lines). If not, click the [Office button] (the Office button is a circular icon with four different-colored squares inside) in the top left corner and then click [New]. If a window pops up, double-click [Blank Workbook].

   - Notice that when you click the [Office button] (go ahead and do it), the [New...] item has a picture (an icon of a blank sheet of paper). (If you clicked on the [Office button], then please press [Esc] on your keyboard -- this will generally "Escape" back to where you were.)

3. In this blank spreadsheet, each little box is called a cell. They are denoted by their column (A, B, C...) and their row (1, 2, 3...). The cell A1 should have a darker box than the others. Notice that your keyboard (probably) has two sets of arrows, one set is shared with the number pad on the right subsection of the keyboard. Notice also that your keyboard has three lights on it -- one is [Num Lock] (or "number lock" or "1 lock"),
another is [Caps Lock] (or "Shift Lock" or "A lock"), and the third is [Scroll Lock]. If [Num Lock] is on, then the number pad will enter numbers when you type. If [Num Lock] is off then the number pad should move the highlighted box around from cell to cell. Play with this and watch the pattern. You can toggle the [Num Lock] light by pressing the [Num Lock] key on your keyboard.

- Please press [Num Lock] several times. This toggles the [Num Lock] light.
- Please press [Caps Lock] several times. This toggles the [Caps Lock] light. (Try typing with this light on and then with this light off.)

4. You can also select the cell of interest either by pointing to a cell with the mouse (point to cell C3 now) and then clicking once (with the left-most mouse button) or by using the arrow keys on the keyboard.

5. At the bottom of the screen you should see three "Tabs" that say [Sheet1], [Sheet2], and [Sheet3]. Select cell A1 and type a word (perhaps your name). Press [Enter]. You will be moved to cell A2 when you hit [Enter]. Move the mouse to the bottom of the screen and click [Sheet2]. Notice that your name is gone (It was on [Sheet1]). Now select cell B3 and type a word (perhaps your major). Press [Ctrl]-[Enter], by which we mean hold the control key [Ctrl] and at the same time, press the [Enter] key. (The [Ctrl] button only works when pressed simultaneously with another key.) You will not be moved to cell B4 when you press [Ctrl]-[Enter]. Switch back and forth between [Sheet1] and [Sheet2] by clicking on the tabs at the bottom of the screen.

6. Go to [Sheet2], select cell B3 (where you entered your major) either by clicking with the mouse or by moving with the arrow-keys, when that cell is highlighted (has a dark box around it) press the [Del] or [Delete] key. Whatever you typed here has now been deleted.

   Go to [Sheet1], select cell A2 (where you entered you name earlier). Rather than deleting the contents of this cell, we will leave your name here and type something else (perhaps your parent's name). When you press [Enter], the new word will be in the cell and the old information is lost forever (as far as the computer is concerned).
3.3 Formatting

1. Go to cell A1, enter \([6/7]\). (Remember to press [Enter]). Notice that Excel changes this to [7-Jun]. It has interpreted your entry as a date: June 7th. When you pressed [Enter] you should have been moved to cell A2. If not, go to cell A2. Enter ['6/7]. Notice that Excel leaves this as [6/7]. The prefix ['] tells Excel that what follows is TEXT and should be accepted as is. When you pressed [Enter] you should have been moved to cell A3. If not, go to cell A3, now. Enter [=6/7]. Notice that Excel changes this to [0.857142857]. (You probably only see [0.857143].) The prefix [=] tells Excel that what follows is a mathematical formula and should be evaluated as such; Six divided by seven is the number you see. You will be using the prefix [=] most of the time as you enter a number or formula into Excel.

2. Select cell A1. There are three ways to select a group of cells. Try each. After you have tried one, select a cell away from the group you have highlighted (like C4 or something).
   
   (a) Keyboard Method: Select cell A1. Press and hold [Shift]. Use the arrow keys to move to cell A2 and then to cell A3. You should see all three cells (A1, A2, and A3) surrounded by a dark border; A1 should be white and the rest are dark.

   (b) Mouse Method: Select cell A1. Hold the left-most mouse button down. While you are pressing the left-mouse-button move the mouse towards you slowly. Every time you get to a new cell, it turns dark and becomes part of the selected region.

   (c) Keyboard and Mouse Method: Select cell A1. Press and hold [Shift]. While holding [Shift], move the mouse to a different cell (like B5) and click the left-mouse-button. Keep holding [Shift], click cell F8, click cell A10, click cell B4.

   Now that you know how to select a group of cells, select the group of cells from step 1. (It should be A1, A2, and A3.) Delete the information by pressing [Del] while the cells are highlighted. Unselect the group of cells by selecting some other single cell.

3. Excel remembers formats: Go to cell A1. Enter [1]. (You should now be in cell A2.) Enter [1] in cell A2. These are different because the previous step set the "date-format" for cell A1 but not for cell A2. Go to cell A1 and type [=][1][Enter]. This is not enough
to change the format. With cell A1 selected, there are three ways to get the window which will change the format.

(a) Select the cell (or cells) to be changed. Right-click the cell (point to the cell with the mouse and press the right-most mouse button). Choose [Format Cells...] from the menu.

(b) Select the cell (or cells) to be changed. At the top of Excel, you should see various tabs such as "Home", "Insert", "Page Layout", etc.,... If the [Home] tab is not already selected, click on it. This tab is then divided up into different sections: "Clipboard", "Font", "Alignment", "Number", "Styles", "Cells", and "Editing". Next to the "Numbers" section there should be a small arrow pointing to the southeast. Click this arrow.

(c) Select the cell (or cells) to be changed. On the "Home" tab, in the "Numbers" section, you should see a drop down box (a small white rectangular box). Clicking on the drop down box will cause a menu to pop up. Click on [More Number Formats...] at the bottom of the menu.

(d) Select the cell (or cells) to be changed. Press [Ctrl]-[1].

Now, in the new window, the [Number] tab should have a dashed line around it. This is the tab we want, but click each of the other tabs so you can see what they do. (You should be able to select [Number], [Alignment], [Font], [Border], [Fill], and [Protection].) Then click the [Number] tab again. Notice that the category [Custom] is highlighted (in blue). Select (click on) the category [Number] and notice that the Sample has two decimal places. In the Decimal places option, click on the down-arrow and change the 2 to a 1; you can click it again to change it to a 0. Click the up- and the down-arrows, but end with it set to 1 decimal place. Notice that the sample changes as you do so. Click [OK] at the bottom of this window. You should now have a 1.0 in cell A1.

4. Go to cell A2. Type [=][A][1][+][1][Enter]. This will put a 2.0 in cell A2 (one more than the value in cell A1). Now go to cell A1 and enter [5]. Notice that cell A2 automatically updates itself to the number 6 (one more than the value in cell A1). Go to cell A3 and type [=][↑][↑][+][3][Enter]. Notice that [↑] is a single key on the keyboard which allows you to move around the screen. Notice that when you hit [↑] once the cell
above where you started (A2) has a dashed box around it. When you hit [↑] the second time, the cell two above where you started (A1) has the dashed box around it. When you then type [+] the dashed box disappears and you find "=A1+1" in your cell. After you hit enter, you should have an 8 in cell A3 (three more than the value in cell A1). Now go up to cell A1 and enter [8]. Notice that cells A2 and A3 change appropriately.

5. With these formulae in the cells (as described in the previous step), select cell A2. Notice that the dark box around cell A2 has a funny lower right corner. When you place the mouse over this, the larger white plus-sign (that was the mouse indicator) becomes a smaller black plus-sign. While the mouse is this smaller, black plus-sign press and hold the left mouse button. (You are now "grabbing" the corner.) Notice what it says at the bottom of the screen: "Drag outside selection to extend series or fill; drag inside to clear." To see what this means, while pressing the left-mouse-button, move the mouse into the cell A2. When cell A2 turns grey, let go of the mouse button. You have erased the formula in that cell!

Press [Ctrl]-[z]. This will "undo" your last command, which in this case was to delete the formula. So the formula should be back. Whenever you make a mistake, press [Ctrl]-[z] to undo it. You can press [Ctrl]-[z] several times to undo several steps.

If you press [Ctrl]-[z] too many times, [Ctrl]-[y] will Redo what has just been undone by a [Ctrl]-[z].

For now, press [Ctrl]-[z] several times and then press [Ctrl]-[y] several times. Now press [Ctrl]-[y] until nothing changes (no more to redo). Finally press [Ctrl]-[z] one time so that there is a formula in cell A2. Or enter [=][A][1][+][1] in cell A2.

Now, select cell A2 and press and hold (grab) the lower right hand corner. With the button pressed, slowly move the mouse towards you on the desk (down the screen) and notice that as you go to each new cell, it turns black (becomes selected). When you get to cell A8 or so, stop moving the mouse and let go of the button. You have copied the formula! Notice that while cell A2 said [=A1+1], cell A3 now says [=A2+1] and cell A4 says [=A3+1]. Go up to cell A1 and enter [1]. All of the cells get updated!

6. Now select cells A1 and A2. (Select cell A1, press and hold the left-mouse-button, move to cell A2, release the mouse button.) Grab the lower right corner of cell A2 and move the mouse to cell B2 (drag it); release the button. Cell B1 should say [2] (one more than A1), but it isn't a formula. Excel assumes you want to begin numbering the columns and
automatically adds one to any number copied into an adjacent cell (!). Notice however that cell B2 is \([=B1+1]\). **When you copy down**, it adjusts the row of the formula (the number); **when you copy across** it adjusts the column of the formula (the letter).

7. We want to change this formula slightly. **Rather than retype it, we will edit it.** Go to cell B2. Press [F2] (not [F][2], there are keys at the top of the keyboard called "function keys" which are special). The formula comes up as \([=B1+1]\); change it to read \([=B$1+1]\). Press [Enter]. Now grab the corner and drag this down a few cells (through B10, for example). Notice that all of these new cells stayed as \([=B$1+1]\). Normally by dragging this formula down, you would change the row numbers. The "\(\$\) protects the formula against change when being copied. Go to cell B1 and enter [18]. All of the cells will change to \([19]\) (one more than cell B1).

8. If cell A1 does now have a value of 1 inside of it, change it to 1 now. Now select cells B1 and B2. Grab the lower right corner of cell B2 and move the mouse to cell C2 (drag it); release the button. Cell C1 should say \([19]\) (one more than B1); recall that Excel automatically adds one to any numbered copied into an adjacent cell (!). Notice however that cell C2 is \([=C$1+1]\). You copied across and it adjusted the column of the formula (the letter). The $ of C$1 only protects the 1. **You can protect** the column only ($C1), the row only (C$1), both row and column ($C$1), or neither (C1). Go to cell C2, press [F2] and use the arrow keys to move to the part of the formula that says C$1. Press [F4]. Press [F4] again. and again. and again. and again. [F4] will cycle through these choices of protection.

You are now ready to enter and manipulate data!!!

### 3.4 Entering Data

When you enter data into Excel, it is a good idea to format the cells appropriately as you enter the data so that you can use this table in your report. It is also easier to read when you look back later.

1. If the spreadsheet you have open from above has some previous unimportant work in it, you should empty it. Click the grey column header A. This will select the entire column (it will turn black). Press [Del] or [Delete]. This will delete the contents of column A. Since we want to empty the entire page, notice that there is a grey square just
left of the column header A and just above the row header 1. Press that square. The entire page should turn black except for one cell where you were before you pressed the grey square. Press [Del] or [Delete]. This will delete the contents of the entire page.

2. Go to cell A1; enter "x (draps)". The column header should say the variable and parenthetically the unit. When you press [Enter], you will be moved to cell A2. Enter the data for x from Table 1. Do not enter the uncertainty yet.

3. Uncertainty: A number with its uncertainty is usually written \( x = 1.0 \pm 0.75 \) draps. We will enter the data, the ±, and the uncertainty each in its own column.

   (a) Plus/Minus: Go to cell B2 (next to your first data point). Type ['][+] and then [Ctrl]-[Enter]. (See the Index to remind yourself of the function of ['] and [Ctrl]-[Enter].) You should still be in cell B2. Type [Ctrl]-[u] to underline the contents of this cell. You can also select the cell and click on the U at the top of the page next to the B and the I.

   (b) Copy: Use the lower right corner (Recall item 5 under formatting) to copy this cell down next to each of the values in column A (i.e., down through B12).

   (c) Resize: Position the mouse between the column header B and the column header C. Notice that the larger white plus-sign becomes a black double arrow when you have the mouse positioned correctly. When it looks like this, double-click the mouse. This will resize column B.

   (d) Enter the Uncertainty: Start in cell C2 and enter [0][.][7][5] (or whatever value). If you are using the same spreadsheet as previously, it will have remembered the format (one decimal place). Right-click cell C2, select menu item [Format Cells...], select [Number], select category [Number], set the number of decimal places to [2] and click [OK]. Rather than repeating this all the way down, grab the lower right corner of cell C2 and drag it down through cell C12, then let go of the mouse button. You will have copied that value all the way down. Now resize column C the same way you resized column B.

   (e) Header: Notice that the "x (draps)" is only in column A. It would be nice to have it across all three columns. Select cells A1, B1, and C1 (click on cell A1 and with the left-mouse button held down, move the mouse across B1 to C1, then let go). Right click someplace in the selected area and select [Format Cells...], Select [Alignment], click on the square next to [Merge cells] (it should place a check
mark in the box). Before you click [OK], under the [Horizontal], click the down-
downarrow and select [Center]. Press [OK] at the bottom of the window. "x (draps)"
should be centered over the data column.

4. Ignore column D for now. Go to cell E2. Enter the data from the second column of
Table 1.

   Go to cell F2. Enter the data from the third column of Table 1.
   Go to cell G2. Enter the data from the last column of Table 1.
   Go to cell H2. Enter the data from the second column of Table 2. Notice that the
data in this table are for specific x values. Please put them in the appropriate rows.
   Go to cell I2. Enter the data from the third column of Table 2 in the appropriate
rows.
   Go to cell J2. Enter the data from the last column of Table 2 in the appropriate
rows.

   Do not put a column header over these cells. We will be using cell E1 later.

5. Skip column K for now. In cell L1, enter "y (cooms)". Center it across cells L1, M1, and
N1. (Recall item 3e.)

6. In cell L2, type \=[average(E2:J2)]. Do not hit [Enter]. With this part typed, point
the mouse to cell E2, hold the left-mouse-button and move the mouse through F2, G2,
H2, I2, and J2, then let go of the mouse button and type [)].[Enter]. The formula should
read \="average(E2:J2)\". Excel is smart enough to ignore empty cells when it averages.
If you want a cell to be counted as zero, then you must enter zero explicitly. The value in
L2 should be 5.6666667 according to the data given to you. (If you calculated 6.1875
then you did not line the data up in the correct rows. Look at Table 2 more closely.) If
you enter a [0] in cell J2, then the value of L2 will change to 4.25 -- do this and then
press [Ctrl]-[z] to undo it. Rather than repeating this all the way down, grab the lower
right corner of cell L2 and drag it down through cell L12, then let go of the mouse button.
You will have (conveniently) copied that formula all the way down.

7. In cell K1 enter [s][p][r][c][a][d]. In cell K2, type \=[max(E2:J2)-min(E2:J2)]. Before you press
[Enter], select the cells E2:J2 (as before), then type [)]][][-][m][i][n][l], select cells E2:J2
again, and type [)].[Enter]. The formula should read "max(E2:J2)-min(E2:J2)\". Again
Excel is smart enough to ignore the empty cells. This formula tells the computer how
8. The Uncertainty: (Recall item 3d.)
   (a) Plus/Minus: Enter a ± in cell M2, which should be the cell next to your first averaged value. (Step 3a: [''][+]Ctrl-[Enter][Ctrl]-[u].)
   (b) Copy: Use the lower right corner to copy this cell down next to each of the values in column L (i.e., down through M12). (Step 3b.)
   (c) Resize: Resize column M. Step 3c: Double-Click between the column headers.)
   (d) Enter the Uncertainty: In cell E1, enter the $y$ precision (1.0 in this case). In cell N2, enter "=max(E$1,K2)".
      i. The dollar-sign is very important! See Step 8 of Formatting for how the $ protects a cell.
      ii. The comma in (E$1,K2) indicates a list of specific cells. The colon was for a range of cells. The set of cells "(A1:A5)" is identical to "(A1,A2,A3,A4,A5)".
         Rather than repeating this all the way down, grab the lower right corner of cell N2 and drag it down through cell N12, then let go of the mouse button. You will have copied that formula all the way down. Now resize column N.

9. **Format the entire page** of data: At this point, the table looks very sloppy. Select the entire page by pressing the grey square just left of the column A header and just above the row 1 header. Right-click somewhere in the selected region, select [Format Cells...], select tab [Number], select category [Number], set the number of decimal places to [2], click [OK] at the bottom of that window, click the mouse anywhere on the page.

3.5 Creating a Graph

Now that your data are in the spreadsheet, you can verify and replace any measurement and everything which was calculated from that number will get updated automatically. With your data in the spreadsheet, this subsection will explain how to create a graph.

Before creating a graph, it is necessary to understand how the layout of data in your spreadsheet can affects the way Excel creates graphs. If your data were lined up in columns
(which isn't the case), then you could highlight your data; Excel can usually figure out
columnated data. However, Excel expects the data for the horizontal (x) axis to be in the first
column and the vertical (y) data to be to the right of that. Our data are not aligned like that this
time. However, we will be taking advantage of some of the assumptions that are built into Excel.

1. Highlight/select the data which are to be plotted on the vertical axis. This should be
   located in the range L2:L12. (See Step 2 of Formatting.)

2. Click the [Insert] tab located at the top of Excel. Under the "Chart" section, you should
   see icons indicating all the different graphs that can be created. Click on the icon labeled
   [Scattered]. A drop down menu should now pop up. Select the icon with a couple of
   small circles and squares but no lines.

   You should now see the graph appear in the middle of the spreadsheet. It would
   be much nicer to place the graph on its own tab so that tab so that it does not interfere
   with the layout of the data. To do this, first click anywhere on the graph. Next, you
   should see an icon in the top right that says [Move Chart]. Click on this.

   A window will pop up asking where you would like to move the location of the
   chart. As the pictures should indicate, the [As new sheet] creates the graph in a new
   sheet which is accessible from the tabs at the bottom of the page. (This is in addition to
   the [Sheet1], [Sheet2], and [Sheet3] which are currently there.)

   (a) Select [As new sheet] by clicking on the white space next to it and typing in a
   name for the graph which will appear on the tab next to [Sheet1]. The value
   defaults to [Chart1]; we suggest using something more descriptive such as "y vs
   x".

   (b) If the "radio button" (white dot) to the left of [New sheet] does not get a black dot
   in it, then click on the white dot there.

   You should be looking at your graph as a full window view in its own page. You
   can get back to the data page by clicking the [Sheet1] tab at the bottom. You can get
   back to the graph by clicking the [Chart1] or [y vs x] tab at the bottom (depending on
   what you named this tab earlier).

3. On your graph, notice that the x-axis runs from 0 to 12. Excel has the correct y values,
   because you highlighted them, but since you did not tell it what the x values were, Excel
   assumed it should use 1, 2, 3, 4, 5... etc. Our x values are not sequential, so we must
explain this to Excel. Select the [Design] tab across the top of Excel. In the "Data" section, click on the [Select Data] icon.

A new window titled "Select Data Source" should pop up. There should be one series defined. (It is currently called "Series1".) Click on the button that says [Edit]. Another window entitled "Edit Series" should pop up.

Next to [Name:], [X Values:], and [Y Values:], there is a white space and a white, red, and blue icon. The icon will (conveniently) allow you to select cell-ranges from the spreadsheet.

i. 

"=Sheet1!$L$2:$L$12" should be in the [Y Values:] slot. This is fine.

ii. Click once in the white space next to [Name:]. Click the [Name:] icon. The window gets small (like a window shade being rolled up), but there is still a white space and a new icon on the right (which looks like a white bar with a red arrow pointing down as in "pull the window shade down"). Click on the [Sheet 1] tab at the bottom of the page. Next, click cell L1. Notice first that since we merged L1 with M1 and N1, all three are surrounded by a blinking dashed box. Notice second that when you did that, the white space filled with "=Sheet1!$L$1". Now click the icon on the right (the white bar with a red arrow) and then click [OK]. Notice now that the window is large, the series name has been replaced with the value of cell L1. If we change L1, it will automatically change this value as well.

iii. Click on the [Edit] button again. Then, click once in the white space next to [X Values:]. Click the [X Values:] icon. The window gets small (again), but there is still a white space and an icon on the right. Go back to Sheet 1 and click cell A2. Notice that when you did that, the white space filled with "=Sheet1!$A$2". Now select the range A2:A12 (the x data). Notice that when you did that, the white space filled with "=Sheet1!$A$2:$A$12". Now click the icon on the right (the white bar with a red arrow) and then click [OK] for both the "Edit Series" window and the "Select Data Source" window.
4. Looking at the graph, we can see that it would be convenient to have titles for the x- and y-axes. In addition, it would be useful to be able to change the title of the main chart and the gridlines.

(a) Right now, the title of the graph should say "y (cooms)". To change the title, simply click on it once and begin to type in the new name of the graph. Press [Enter]. (If you title the graph by one axis versus another, always use the vertical axis versus the horizontal axis: y vs x.) The title of the graph should now be changed.

(b) To add titles for the x- and y-axes, first select the [Layout] tab at the top of Excel. Underneath the "Labels" section, you should see an icon entitled "Axis Titles". Click on this icon and underneath "Primary Horizontal Axis Titles", click on [Title Below Axis]. Click on the "Axis Titles" icon once again. This time, underneath "Primary Vertical Axis Titles", select [Rotated Title].

You should now be able to change the name of the axis title for both the x- and y-axes by clicking on them once and then typing in the new title. For the x-axis, enter the variable and, in parentheses, the unit: x (draps). For the y-axis, enter the variable and, in parentheses, the unit: y (cooms).

(c) Notice on the graph that there are horizontal gridlines running along the graph. To add vertical gridlines, first locate and click on the "Gridlines" icon underneath the "Axes" section of the "Layout" tab. Underneath "Primary Vertical Gridlines", select [Major Gridlines].

Notice that there are other choices besides [Major Gridlines] for both the horizontal and vertical axes. Turn them all on and off to see what they do. Some professors like no gridlines, others like just y-major, others like x-major. Ask your professor which is preferred.

Minor gridlines are useful if you are measuring something from the graph. We will not be doing this. If you have minor gridlines turned on, then it is difficult to make adjustments later. If you must use minor gridlines, you can do this after you have created and formatted the graph.

(d) Notice that a legend is located to the right of the graph. If we had more than one set of data, a legend would be useful. For our purposes in this lab, we do not need a legend. To remove the legend, go to the "Layout" tab. Underneath the "Labels"
section, click on the [Legend] icon and then click on [None]. The graph should automatically resize itself after removing the legend.

5. Notice that the **axis labels are formatted** (like the data columns) to two decimal places. In this case we do not need (nor want) two decimals. There are several format modifications we want to be able to make. Right-click on one of the axes. Select [Format Axis...] to get a new window.

   (a) Select the [Number] tab. Change the [Decimal Places:] to 0 (zero). Notice that this turns off the [Linked to Source] button which would maintain the format on the graph of the source data in [Sheet1].

   (b) Select the [Axis Options] tab. At the top, you should see different ways to change the scale of the graph. We will not be doing anything with this at this time, but you may want to be able to change the scale at some point in the future. This is where you do so.

   (c) Underneath the scaling options on the [Axis Options] tab, you should see where you can change the formats for "Major tick mark type," "Minor tick mark type," and "Axis labels". Different professors like different formats. For practice, set the [Major tick mark type] to [Cross], the [Minor tick mark type] to [Outside], and the [Axis Labels] to [Low]. The major gridlines may hide the changes to the major tick marks. The minor gridlines may hide the changes to the minor tick marks. Setting the labels to [Low] will only have an effect if the other axis data range includes negative numbers.

6. Repeat with other axis.

7. We will now add the **error-bars** to the graph.

   (a) Under the "Analysis" section of the "Layout" tab, you should see an icon that says [Error Bars] below it. Click on the [Error Bars] icon and a menu will pop up. Select [More Error Bar Options...] from this menu.

   (b) A new window which says "Format Error Bars" should pop up. On the left, you will the tabs [Vertical Error Bars], [Line Color], [Line Style], and [Shadow]. If it is not already selected, click on [Vertical Error Bars].

      In some cases (like for our x data) you can use the fixed error bars, but we won't. In other cases, you can use the fixed-percentage error bars, but we won't. We want to add custom error bars to our graph. Towards the bottom of the
[Vertical Error Bars] tab, you should see different options for the "Error Amount". Click on the radio button (small circular button) next to "Custom". When you do this, the [Specify Value] button should now be available for you to click on. Before click on the [Specify Value] button, click anywhere along the top of the "Format Error Bars" window and drag it to the left side of the screen so that it is not covering up the graph (you will not be able to see the whole "Format Error Bars" window anymore). Now, click on the [Specify Value] button.

A small window entitled "Custom Error Bars" should pop up. Click the "spreadsheet" icon to the right of the white space which is beneath "Positive Error Value". The window should get small as before. Click on the page-tab [Sheet1] (or wherever your data is) to find your data page. Notice that the y-error-bars are in the range N2:N12. Highlight this set of data so that the value "=Sheet1!$N$2:$N$12" is entered in the blank. Click the icon to the right of the white space (the white bar with a red arrow) to go back to the [Format Error Bars] window and click [OK]. Notice that it has automatically darkened the [Plus] option for which side to place the error bar. Repeat with the "Negative Error Value" using the same set of data "=Sheet1!$N$2:$N$12"). This should automatically bump you up from the [Plus] square to the [Both] square. Finally, click [Close].

We now want to add error bars for the x-axis. To do this, locate the drop-down menu located in the "Current Selection" section of the "Layout" tab. From the drop-down menu, select [Series "y (cooms)" X Error Bars] and then click on [Format Selection] (right below the drop-down menu). Repeat with the [Horizontal Error Bars] tab using the range C2:C12 (which should have your x-error data), highlighting the set of data so that the value "=Sheet1!$C$2:$C$12" is in the blank.

Click [OK] and notice that your graphed data now has error bars. A reasonable trendline ought to pass within all of the error bars. If it does not, then you should review that data point. Look for typos and miscalculations in that point specifically.

We are now ready to add a trendline. This line will average out the bumps in the data (due to minor imprecision in the measurements).
(a) When the mouse points to a data point, a small help box will tell you the Series Name and the values of that data point: (x-value, y-value). Right-click any data point and select [Add Trendline...]. (It is possible to create more than one trendline for a single set of data.) If your data points are exactly along the trendline, then once you have created a trendline, it will be difficult to point to the data because they lie underneath the trendline.

(b) On the [Trendline Options] tab, we will select the formula which we expect the data to follow. If we have made a poor choice, then the "R-squared" value will not be close to one. This is an indication that we should start over with a new trendline formula. For now, your data should be pretty obviously linear. Make sure that the [Linear] option is blackened (selected).

(c) On the [Trendline Options] tab, there are other ways in which we can format the trendline.

i. The [Trendline Name] option is asking for what will be displayed in the Legend. Since we have not made use of the legend, this will not affect our graph.

ii. The [Forecast] option allows you to extend the trendline. This might be used if you are interested in where it crosses the axis, although this can also be calculated from the equation of the trendline.

iii. The [Set intercept] forces the trendline through a specific point. Generally this is frowned upon unless your theory restricts the value. (Do not use this.)

iv. Click the box next to [Display equation on chart] to display the equation of the trendline. This tells you what the pattern that the data are trying to follow. It "averages out" the bumps which are probably due to imprecise measurements.

v. Click the box next to [Display R-squared value on chart]. This will show you how well the data agrees with this pattern. If $R^2=1$, then your data fits this trend exactly. If your $R^2$ value is less than (rough estimate) 0.98, then you should review your measurement technique. If your $R^2$ value is
less than 0.94, then you may want to consider a different trendline formula.

(d) Click [Close]. You will see the graph with the line, the equation, and the R-squared value. By pointing to the equation, holding the left-mouse button down, and moving the mouse, you can move the equation to a location which is easy to read. Let go of the mouse button when you have decided on a location.

(e) You can edit your trendline by right-clicking on it and selecting [Format trendline...].

9. Evaluate your data. The trendline should pass through at least the corner of the implied box made by the error bars. Most of our data are accurate (according to the trendline), except perhaps $x = 11$ and 22; and even those are reasonable (i.e., within uncertainty). The imprecise data have large error bars. The description of the graph is that "the data are consistent with a linear relationship." We can therefore expect an equation of the form $y = mx + b$ where, for our data, $m = 1.2097$ and $b = 4.3964$. (In fact, we generated the data using a random variation from $y = 1.2x + 4.6$; but you wouldn't know that in the lab.)

(a) Notice that data point $x=22$ just barely extends its error-bars to touch the trendline. The "just barely" is fairly irrelevant. However, if you find a data point for which the error bars do not reach the trendline, then you should question either that data point or the assumption used to pick the form of the trendline. Remeasure that point several times to verify consistency. You may have written the number down incorrectly or misread the instrument.

i. If you find that you did make a mistake, try to figure out what the mistake was. Mention in your procedure section that the reader should be careful to not make this or that mistake.

ii. If you find that you did not make a mistake; that the discrepancy is real, then check the error bars. Are you underestimating your uncertainty? If yes, then adjust them. If not, then you have shown the data to be inconsistent and should propose an improved measurement technique to verify this apparent anomaly.

* If you find that you did not make a mistake and that it cannot be explained by uncertainty, this is exciting news! It is what experimenters look for,
but when found, you have to show that you are actually seeing an anomaly and not a mistake!

(b) Since there are measurement uncertainties in the data, the fitted trendline will not be the exact theoretical equation. Looking at our trendline, we would assume the theory to be \( y = 1.2x + 4.4 \) (Notice that this does not quite agree with the equation which actually generated the data.) So, we need to consider the \textbf{uncertainty in the slope and the intercept}.

i. Using the tabs at the bottom of the screen, go to your data page [Sheet1].

ii. The \( x \)-data are in A2:A12. The \( y \) data are in L2:L12. Go to cell K14. Enter \([S][l][o][p][e]=\).

iii. In cell K15, enter \([I][n][t][e][r][c][e][p]=\)

iv. In cell L14, enter the formula: 
\[
=\text{index(index(linest(L2:L12,A2:A12,true,true),1),1)}
\]

The Excel function [LINEST] will generate the data relevant to a linear trendline. (It only works for linear trendlines.) The first "1" means "give the value, not the uncertainty." The second "1" means "give the slope, not the intercept." Rather than typing L2:L12, you can use the mouse to select that range. Similarly for A2:A12. But it must be \( y \)-values and then \( x \)-values. The value in L14 should be the same as the slope on the graph (but it may be rounded to a different number of decimals).

v. In cell L15, enter the formula: 
\[
=\text{index(index(linest(L2:L12,A2:A12,true,true),1),2)}
\]

The "1" means "give the value, not the uncertainty." The "2" means "give the intercept, not the slope." This may be easier to do by going to cell L14 and typing the following on the keyboard: (Remember that [Shift]-[Home] means hold the [Shift] key down and press the [Home] key.)

\[
[F2] [Shift]-[Home] \quad [Ctrl]-[c] [Esc] ↓ [Ctrl]-[v]
\]

and then 
\[
[F2] \leftarrow \text{[Backspace]} \ [2] \ [Enter]
\]

The value in L15 should be the same as the intercept on the graph (but it may be rounded to a different number of decimals).
vi. To paste the ± into the two cells, go to cell M12; type [Ctrl]-[c] (to copy the cell), then go to cell M14 and type [Shift]-[↓] [Ctrl]-[v].

vii. In cell N14, enter the formula:

```
=index(index(linest(L2:L12,A2:A12,true,true),2),1)
```

The "2" means "give the uncertainty, not the value." The "1" means "give the slope, not the intercept." The value in N14 should be the uncertainty in the slope of the graph. This may be easier to do by going to cell L14 and typing the following on the keyboard:

```
[F2] [Shift]-[Home] [Ctrl]-[c]
[Esc] [→] [→] [Ctrl]-[v]
```

and then

```
[F2] [←] [←] [←] [←]
[Backspace] [2] [Enter]
```

The value in N15 should be the uncertainty in the intercept of the graph.

viii. In cell N15, enter the formula:

```
=index(index(linest(L2:L12,A2:A12,true,true),2),2)
```

The first "2" means "give the uncertainty, not the value." The second "2" means "give the intercept, not the slope." This may be easier to do by going to cell L15 and typing the following on the keyboard:

```
[F2] [Shift]-[Home] [Ctrl]-[c]
[Esc] [→] [→] [Ctrl]-[v]
```

and then

```
[F2] [←] [←] [←] [←]
[Backspace] [2] [Enter]
```

(c) The values that we get (to two decimal places) are: (please notice the units!!!)

- Slope = 1.21 ± 0.02 cooms/drap
- Intercept = 4.40 ± 0.31 cooms

So, the slope is quite consistent with the 1.2 theoretical value and the intercept is reasonably consistent with the theoretical value. The slope only has a 1.6%-uncertainty and the intercept has a 7%-uncertainty.

9. Report your results: The data are consistent with (meaning that the error-bars overlap with) a line with slope 1.21 ± 0.02 cooms/drap and intercept 4.4 ± 0.3 cooms. Notice that
since the uncertainty is in the first decimal, we should not report the second (as it is insignificant). These number can also be reported as $1.21(2)^{\text{cooms}/\text{drap}}$ and $4.4(3)$ cooms. Be aware that the notation $(2)$ implies that it is an uncertainty in the last decimal place listed (the second decimal place) and the $(3)$ implies the same about the 4.4 (the uncertainty is in the first decimal place).

### 3.6 Calculated Data

The true point of using a spread sheet in a scientific class is so that you don't have to repeat a calculation for each point in a data set. You can type it in once and then copy-and-paste it all the way down. This is specifically why computers were invented (to compute), and is specifically what they are good at: tedious repetition. If you find using a computer tedious or repetitious, then you are probably not using the computer correctly; let the computer do the repetitive part. Now that you have been introduced the next two subsections reinforce your ability and show you how to create calculated data.

1. Create the set of calculated data.
   
   (a) Go to your data sheet [Sheet1] by clicking the appropriate tab at the bottom of the page.

   (b) We are going to put the calculated data in columns O, P, and Q. In order to use the same format as was used for $y$, select the range L1:N12. (point to L1, press and hold the left-mouse button, move the mouse to N12, let go). Type [Ctrl]-[c] (to copy that range). Go to cell O1. Type [Ctrl]-[v] (to paste the data). Notice that O1:Q1 is merged, that the ± has been copied, and that the two-decimal format has been copied as well. (yay!)

   (c) But these are not the numbers that we want, so we will have to get rid of them. Select O2:O12 (you can do this quickly with the keyboard by pointing to O2 and typing [Shift]-[End]-[↓]) and press [Del] or [Delete] to delete that data. Select Q2:Q12 (point to Q2 and type [Shift]-[End]-[↓]) and press [Del] or [Delete] to delete that data. Go to O1 and enter "z (coom-draps)".

   (d) Resize column P. (See Step 3c under "Entering Data")

   (e) We will assume that $z$ can be calculated according to $z = y (x+2)$. Go to O2 and type [=], click cell L2, type [*][0], click cell A2, type [+]2[)][Enter]. The value should be 17.00 and the formula should read: 

\[=L2*(A2+2)\].
(f) Copy that all the way down through O12. (Step 5 under "Formatting": Click cell O2, point to the unique lower-right corner, so that the mouse becomes a black +, press and while holding the left mouse-button and move the mouse to O12, let go.)

(g) Since the calculated uncertainty for \( z \) is

\[
\frac{\Delta z}{z} = \frac{\Delta y}{y} + \frac{\Delta x}{x+2}
\]

or

\[
\Delta z = z \left[ \frac{\Delta y}{y} + \frac{\Delta x}{x+2} \right]
\]

go to cell Q2 and enter the formula "=O2*(N2/L2+C2/(A2+2))" by doing the following: type [=], click cell O2, type [*[()]], click cell N2, type [/], click cell L2, type [+] , click cell C2, type [/[()]], click cell A2, type [+][2][)]][Enter].

(h) Copy that all the way down through Q12. (Step 5 under "Formatting")

2. Create a graph of \( z \) versus \( x \).

(a) Rather than recreate the entire graph step-by-step, which would be tedious, we will copy and modify the old graph! Right-click on the old graph tab (which should either be [Chart1] or [y vs x]). Select [Move or Copy...]. Click (This is an important step!!!) to check the box by [Create a copy]. Press [Enter] or click [OK]. Double click the [Chart1 (2)] or [y vs x (2)] tab that you have just created. When it turns black, type [z][][v][s][][x][Enter].

(b) Right-click a data point on the new graph and click on [Select Data...]. Click on the [Edit] button. Click the funny spreadsheet box to the far right of [Y Values]. It should produce a dashed line around the \( y \) data. Highlight the \( z \) data O2:O12 instead and press [Enter]. Now press [Enter] or click [OK]. Notice that the trend of your data is no longer linear, so we will have to fix the trendline.

(c) Go to the "Layout" tab and select [Series "y (cooms)" Y Error Bars] from the drop-down menu in the "Current Selection" section. Click on the [Format Selection] button (located right below the drop-down menu). On the [Custom:] option, click on the [Specify Value] button. Then, click on the spreadsheet button to the far right of the white bar below "Positive Error Value". It should give a dashed line around the \( y \) uncertainty. Select the \( z \) uncertainty Q2:Q12. Press [Enter]. Click on the spreadsheet button to the far right of the white bar below
"Negative Error Value". It should give a dashed line around the y uncertainty.
Select the z uncertainty Q2:Q12. Press [Enter] and then click [Close].

3. Fix the trendline: right-click the trendline and select [Format Trendline...]. Under the [Trendline Options] tab, select the [polynomial] window, verify that the number 2 is selected nearby (so that it is a quadratic), press [Enter] or click [Close].

4. Fix the titles on the graph by clicking on them once and then typing in the new name. Press [Enter] when finished.

3.7 Printing Data Sheet

There are a couple of options for this and it will depend on exactly how your data-set is laid out. You can even highlight and move your data around without changing any of the calculated values! With this data-set, we would like to have it all on one page, with the essential data listed first and the measured y values listed later. But first we will look at a few options that may be appropriate in later labs.

1. Go to your data sheet.

2. Highlight from A1 through Q15 (all of your data). Click on the [Office Button] in the left-left corner of the page. Under "Print", click [Print Preview] on the [File] Menu which you just pulled up. Notice that the data does not fit on a single page. This is ugly.
   (a) Select [Page Setup]. On the [Page] tab of the new window, click [Landscape]. Click [OK]. Now, the data will fit, but it is horizontal. Sometimes this will be nice, but not here.
   (b) Select [Page Setup]. On the [Page] tab of the new window, click [Portrait]. Click [Fit to:] so that it reads "Fit to: [1] page(s) wide by [1] tall." Click [OK]. Now, the data will fit and it is vertical, but it is a bit small, and we have a large mostly-empty page. This will also be a good format for some data, but not for this data set.
   (c) Click [Close Print Preview].

3. You should be back at your data page. Notice the column headers A through Q. Click the column header E. Notice that the column turns black. Now, Press and hold the mouse button on the column header E, then with the button still held, move across to column J. Columns E, F, G, H, I, and J should all be black. Right-click in this blackened region. Select [Hide]. (These columns are still there.) Now, click on the [Office Button]
at the top of the page. Click [Print Preview] under [Print] on the menu which you just pulled up.

(a) Notice that the data all fits nicely (although there is still a good bit of room on the page). Unfortunately, we would also like to include the data which are hidden.

(b) Click [Close Print Preview] again.

4. Highlight column headers D and K (which should currently be adjacent). Right-click in the blackened area and select [Unhide]. All of your data should be back.

(a) Highlight the data in cells E1 through K12. Point to the black edge of the highlighted region (the mouse should become a thin black plus sign with arrows pointing out in four directions when you are in the right place). Press and hold the left-mouse-button while moving the mouse around. Place the upper left corner in cell A17 and then let go of the mouse button. Notice that the data in column B doesn't fit and is displayed as ##. Highlight the data in cells B17:G28. Move it all over one column. Resize column C (Click between the C and D column headers).

(b) Highlight cells K1:Q15. Move them so that the upper left corner is in cell D1. Move F17:H28 one column to the right. Highlight I17:I28. Move this set of cells to the right by one column.Resize columns F and I (where the ± are).

(c) (Niceties) You might also wish to resize columns D, G and J, but it is not necessary. You might also want to add a comment in cell C17: Measured y values, average-value listed above.

(d) (Niceties) It would be very helpful if you could also change the title of every graph and data sheet you create to include your name and the name of your partners.

(e) Now, click on the [Office Button] in the top-left corner of the page. Under "Print", click [Print Preview] on the menu which you just pulled up.

(f) Click [Print...] at the top of the page.

(g) The [Print What] option should be set to [Active Sheet(s)]. Click [OK].

5. Smile happily.

6. Turn in your data sheet and your graphs, please. You can do it online just by submitting your MS-Excel file through Moodle or you can print it out (as described above) and turn it on paper.
**Table 3: Some Key Combinations**

<table>
<thead>
<tr>
<th>Key Combination</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter</td>
<td>Enter information in a cell and move down one row</td>
</tr>
<tr>
<td>Ctrl-[Enter]</td>
<td>Enter information in a cell and remain in current cell</td>
</tr>
<tr>
<td>Ctrl-[1]</td>
<td>[Home][Number][More Number Formats...] Open menu to format selected cells</td>
</tr>
<tr>
<td>Ctrl-[2]</td>
<td>[Ctrl]-[b] selected cell/text</td>
</tr>
<tr>
<td>Ctrl-[3]</td>
<td>[Ctrl]-[i] selected cell/text</td>
</tr>
<tr>
<td>Ctrl-[4]</td>
<td>[Ctrl]-[u] selected cell/text</td>
</tr>
<tr>
<td>Ctrl-[5]</td>
<td>Works for when you are using an OUTLINE</td>
</tr>
<tr>
<td>Ctrl-[6]</td>
<td>Hide selected rows</td>
</tr>
<tr>
<td>Ctrl-[7]</td>
<td>[Office Button] [New...] Open a new blank Excel document</td>
</tr>
<tr>
<td>Ctrl-[8]</td>
<td>[Office Button] [Save] Save document with given name</td>
</tr>
<tr>
<td>Ctrl-[9]</td>
<td>[Ctrl]-[g] Goto a specified cell</td>
</tr>
<tr>
<td>Ctrl-[n]</td>
<td>[Office Button] [Save] Save document with given name</td>
</tr>
<tr>
<td>Ctrl-[y]</td>
<td>Redo latest Undo, feature is recursive</td>
</tr>
<tr>
<td>Ctrl-[z]</td>
<td>Undo latest revision, feature is recursive</td>
</tr>
<tr>
<td>F1</td>
<td>Get Help</td>
</tr>
<tr>
<td>F2</td>
<td>Edit the contents of a cell</td>
</tr>
<tr>
<td>F3</td>
<td>Cycles through these choices of protection for a formula</td>
</tr>
<tr>
<td>F4</td>
<td>Spell Check Document</td>
</tr>
<tr>
<td>F5</td>
<td>Goto a specified cell</td>
</tr>
<tr>
<td>F6</td>
<td></td>
</tr>
<tr>
<td>F7</td>
<td></td>
</tr>
<tr>
<td>F8</td>
<td></td>
</tr>
<tr>
<td>F9</td>
<td></td>
</tr>
</tbody>
</table>
Create a blank Chart

[Office Button] [Save As...]

Save document with option to change the name

Table 4: Some Excel Functions. In each case, RANGE has either the format (E3,E4,E5,E6,E7,E8) or (E3:E8).

=average(RANGE) Average a column or row of numbers

=max(RANGE) Find the maximum of a set of numbers

=min(RANGE) Find the minimum of a set of numbers

=linest(RANGE,RANGE,TRUE,TRUE) Find the statistics associated with the best fit line